Getting Started with Motorcentral
A quick guide to using Motorcentral for the first time

This document is provided “as-is”. Information in this document, including URL and other Internet Web site references, may be
subject to change without notice.
Any examples depicted herein are provided for illustration only and are fictitious. No real association or connection is intended
or should be inferred.
This document does not provide you with any legal rights to any intellectual property of the Motorcentral product. You may
copy and use this document for your internal, reference purposes.
Copyright © 2012 Limelight Software Limited. All rights reserved.

Table of Contents
Installing Motorcentral ...................................................................................................................... 3
Connecting Motorcentral to Your Database ....................................................................................... 3
Setting Up Your Dealership ................................................................................................................ 5
Adding Your First Vehicle ................................................................................................................... 6
Completing Your First Sale ................................................................................................................. 9
Exporting Your Vehicles to Websites.................................................................................................. 9
Backing Up Your Data ...................................................................................................................... 11
Deleting a Vehicle............................................................................................................................ 11
Cancelling a Sale .............................................................................................................................. 12
Getting Further Help ....................................................................................................................... 12
Contacting Motorcentral Support .................................................................................................... 12

2

Installing Motorcentral
To install Motorcentral on a Desktop PC, ensure the computer meets the minimum system
requirements (http://support.getmotorcentral.co.nz/entries/20049792-system-requirements) and then
complete the following:
1.

Download the latest version of Motorcentral from
http://www.getmotorcentral.co.nz/Userfiles/Apps/MC/latest/motorcentral.msi and save to a
location on your computer (eg. Desktop)

2.

Once downloaded navigate to the downloaded motorcentral.msi file and run it.
If you are prompted with a Security Warning, click Run to proceed.
Windows Vista / Windows 7
You may also see a User Account Control message. In this case, allow the setup to run by Clicking Yes.

3.

Next the Motorcentral installer will launch. Continue to follow the prompts and instructions of
the installer until it completes installing Motorcentral.

4.

You have now successfully installed Motorcentral. You should see a new icon on your Desktop
from which you can launch the Motorcentral application.

Connecting Motorcentral to Your Database
Each installation of Motorcentral needs to know ‘where to look’ for your company’s data. We refer to
this piece of information as your Database Connection string. If you are unsure of your Database
Connection string please ask your System Administrator or contact the Motorcentral Support team.
First Time Use:
1.

Launch Motorcentral and you will be presented immediately with the Database Connection
window. Enter your Database Connection string (Cut & Paste) in its entirety and click OK.
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2.

If the Database Connection is correct, you will be redirected to the Motorcentral login screen.

Previous Installation:
1.

Launch Motorcentral and at the login screen select Database from the File menu.

2.

Enter your Database Connection string in its entirety and click OK.

3.

If the Database Connection is correct, you will be returned to the Motorcentral login screen.

If an incorrect database is entered, an error will show. Please attempt to re-enter your Database
Connection string and try again. If the problem persists contact the Motorcentral Support team.
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The Motorcentral Interface

Figure 1 - The main screen of Motorcentral

The main screen of Motorcentral consists of four key areas you should be aware:
1. Main menu: can be used to access most functions of the software
2. Navigation menu: quick access to the most commonly used components of Motorcentral.
Consists of:
a. Home: a summary of your business and its key indicators
b. Vehicles: manage your vehicle inventory and vehicle related functions
c. Opportunities: manage your sale opportunities
d. Contacts: manage your customers and suppliers as well as interactions
e. Sales: manage your vehicle sales
f. Export: export your vehicles to your website and other third parties
g. Reports: view and print reports about your business
3. Context Search: in some areas (eg vehicles, sales etc) you can utilise a search function to
find the items you are after.
4. Workspace: displays your search results and/or gives you access to functions to the tab you
have selected in the Navigation menu.
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Setting Up Your Dealership
Video Tutorial available at:
http://support.getmotorcentral.co.nz/entries/20051521-tutorial-setting-up-your-dealerships

Motorcentral relies on some key information about each of your dealerships such as GST Numbers,
Motor Vehicle Traders Numbers and contact details. For example, it uses this information when
creating items like Consumer Information Notices and Vehicle Offer and Sale Agreements.
To configure your dealerships information, complete the following:
1. From the main screen select Tools > Dealerships from the menu. You will be presented with
a list of your dealerships.
2. Select the dealership you wish to configure and click the Edit button to open the Dealerships
settings.
3. Enter the appropriate information about your Dealership into each section of the Dealership
wizard, clicking the Next button until completion. Below are descriptions of some of the less
self-explanatory fields if required:
Dealership Short Code: A two character code used to identify this dealership versus other
dealerships you may have. An example may be to use CH or C1 for your Christchurch
dealership versus AK or A1 for your Auckland dealership.
Logo: Insert a logo graphic for each dealership. This logo will be displayed throughout the
software and various reports + marketing material.
If all your dealerships are not listed please contact the Motorcentral support team who will help add
other dealerships as necessary.

Adding Your First Vehicle
Video Tutorial available at:
http://support.getmotorcentral.co.nz/entries/20049438-tutorial-adding-your-first-vehicle

Motorcentral comes equipped with the ability to manage and sell multiple vehicle classes including:
-

Passenger Vehicles (cars)
Good Vehicles (trucks)
Motorcycles
Caravans/Trailers (no engine)

When entering any new vehicle you will first need to select the type of vehicle as based on this
decision different information can be entered about that particular class of vehicle.

6

To add a vehicle:
1. Navigate to the Vehicles tab in the Navigation menu
2. Below the context search area you will see a button labelled New.
a. Clicking the New button will automatically create a vehicle of your default vehicle
class type; or
b. Clicking the down arrow next to the New button will allow you to select a different
type of vehicle class.

Selecting either option will create a new window allowing you to add details about your new vehicle.
We recommend proceeding through each tab in the order they are presented and have outlined
some key components of some tabs below:
General Tab:
Fuelsaver Information: Ensure the vehicle has a Registration Plate or VIN number entered and click
the Retrieve button to get the latest Fuelsaver information for that vehicle. You can also print a
Fuelsaver Label by clicking the Print button in the same area.
Purchase Info Tab:
Purchase Type: Selecting one of the different purchase types will determine which costs are
associated with the purchase of that vehicle. For example, an Imported vehicle will allow for foreign
currency entry and expenses such as Customs & Port Charges.
Online Tutorial about foreign currency fields available at:
http://support.getmotorcentral.co.nz/entries/20070837-understanding-the-currency-field

Landed Cost Details: Clicking the Details button will allow you to enter the various costs associated
with the purchase and delivery of the vehicle.
Expenses Tab:
Add Expense: To add a reconditioning item or expense to a vehicle simply click the Add Expense…
button. A new window will appear where you can enter the necessary information about the
expense item.
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Mechanical Tab:
Odometer: Motorcentral keeps a history of the Odometer Readings of each vehicle over the history
of the vehicle. To enter a new reading click the Add Reading… button and enter the value of the
reading along with the date it was recorded.

Images Tab:
Add Image: Motorcentral allows for the addition of up to 20 images per vehicle. To add an image,
click the Add Image… button and browse to the location on your computer where the image is.
Highlight the appropriate image or images and then click the Open button.
Thumbnails of the images will appear and you may reorder the images by clicking and dragging them
individually.
Image Overlays: If you’d like to overlay an image on top of your vehicle images, for example to
display your company logo, simply select the appropriate overlay from the dropdown selection box.
You may select an overlay for both the first image of the series, and then separately for the
remaining photos (if desired).
Online Help about Image Overlays available at:
http://support.getmotorcentral.co.nz/entries/20952901-using-vehicle-image-overlays

Administration Tab:
Pricing: Use the four different pricing fields to create the various prices you need for each vehicle.
Selecting a Special Price will allow you to discount a vehicle from its original retail Price. The OnRoad Costs field allows you to add an On-Road Costs value to the Retail and Special Pricing.
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Completing Your First Sale
Video Tutorial available at:
http://support.getmotorcentral.co.nz/entries/20050772-tutorial-completing-your-first-sale

We urge you to view the online video above as an introduction to the completion of your first
vehicle sale.

Exporting Your Vehicles to Websites
Motorcentral allows for the exporting of your vehicles to your own website and other third parties
including (but not limited to) Autobase, AutoTrader and DriveSouth.
Please Note: In order to connect to an Exporter Website you will first need to obtain the connection details from each of
your providers. When contacting any provider, advise them you will be using Motorcentral 3 to export your data.

To setup an export:
1. Click on the Export tab in the navigation menu of the main window.

2. You will see a list of the most common exporters. If you cannot see the exporter you require
please contact the Motorcentral Support Team who will help to add it to the list
3. Select the Exporter you wish to set up by clicking on it in the list. To the right information
about that exporter will appear
4. Click on the Admin tab to begin configuring the Exporter. Enter the details given to you by
your provider. For instructions on specific exporters please contact Motorcentral Support.

5. Once entered click the Save Settings button to save your Export settings.
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Once an Exporter has been correctly setup you can begin to export your vehicle information to that
website. In order to Export complete the following:
1. Navigate to the Export tab in the navigation menu
2. Select the Exporter you wish to set up by clicking on it in the list
3. Click the Export Now button to begin exporting
If the Exporter is working correctly it will begin to show its progress. Each exporter is run
independently of another so you can export to more than one location at the same time. Simply
repeat the steps above for each Exporter whilst the others are running.
If you do not wish for a vehicle to be exported to all or only particular Export options, you can select
this by completing the following:
1. Locate and open the vehicle you wish to alter the export information for
2. Click on the Export tab of the vehicle
3. Under the Export Settings section you will see the current locations this vehicle is being
exported to. If you wish for this vehicle to be exported to any available Export option
(including options added at a later date) select the Include in All Exports checkbox
4. Otherwise, uncheck the same checkbox to exclude this vehicle from all Export options or
once the Include in All Exports checkbox is unchecked, only select those options you require

By default when a new vehicle is added to Motorcentral it is automatically checked to Include in All
Exports. If you prefer for new vehicles to not be included by default you can alter this as follows:
1. From the main menu select Tools > Settings
2. Select the Vehicle tab
3. Uncheck the Include in All Exports checkbox under the Default Export Settings field
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Backing Up Your Data
It is important to continuously backup your Motorcentral data. Accordingly, Motorcentral offers an
in-built Backup function which when performed will allow you the ability, when necessary, to restore
your dealerships data back to that point in time.
Before using the backup function for the first time you will need to configure it. To configure
complete the following:
1. From the main screen select Tools > Housekeeping from the menu.
2. Select the type of backup for both your vehicle data and vehicle images. Our recommended
option is All data and Important Images.
3. Next select the location where the backup file should save to by clicking the Ellipsis (…)
button next to the Backup Folder field. You can select any location recognised by your
computer including pen drives and other portable storage solutions.
4. When you are ready to backup, click the Backup Now button to attempt your first backup.
We recommend if saving to a pen drive or other portable device you set your backup location to a
hard drive on your computer and then copy across the file upon Backup completion. This will allow
the back up to correctly work even when the pen drive is not plugged into your computer.
Once you have completed the initial configuration you can complete a backup at any time.
1. From the main screen select File > Backup.

Deleting a Vehicle
To delete a vehicle from your stock complete the following:
1. From the main screen switch to the Vehicles tab and search for the vehicle you wish to
delete.
2. In the vehicle results list identify the vehicle you wish to delete and right-click it. From the
context menu presented select Delete Vehicle.
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3. You will be asked to enter a reason for deleting this vehicle. Enter a reason and click OK to
confirm deletion.
For security purposes, any deleted vehicle is recorded in the Event Log along with the user who
deleted it and their reason for deletion.

Cancelling a Sale
If you need to cancel a sale, complete the following:
1. From the main screen switch to the Sales tab and search for the sale you wish to cancel.
2. In the sales results list identify the sale you wish to cancel and right-click on it. From the
context menu presented select Cancel Sale Agreement.
3. If the sale has any trade-in vehicles associated with it you will need to decide if you want
these vehicles to remain in stock or to also be permanently deleted.
Cancelling a sale will automatically add the sold vehicle (or vehicles) back into your current stock.

Getting Further Help
Limelight Software offers a comprehensive Motorcentral help guide and tutorial videos at:
http://support.getmotorcentral.co.nz/
If you are unable to find the information you require please contact our friendly support team (see
below) with your query.

Contacting Motorcentral Support
Need technical support now? Please email support@getmotorcentral.co.nz. We endeavour to
respond to all support issues within 2 hours during normal business hours.
Alternatively, if you have an active support pack you may call one of the following numbers for
telephone assistance. Please have your customer number ready to validate your support pack.
NZ Support - 0800 MCENTR (623 687) / 03 741 5026 (CHC)
Please Note: Calls cost $1.50 per min unless you have a prearranged support pack.
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